
Mesh  Editor  has  recently  had  a  complete 
rebuild. The feature list has grown very long and 
contains all of the functions you would expect 
in an advanced mesh editing utility.  Ideal for 
reshaping  and  extruding  meshes  right  within 
Unity.  This  program  makes  manipulating  the 
vertices, edges and triangles of meshes as easy 
as possible.

Introduction Video
Getting Started

To open the program first click on the Window menu item on the Unity menu bar, scroll down 
to the Mesh Editor item and then click on Open Window.

To start editing, first select a game object that has a 
mesh  filter  component  attached.  Note  that  it  can 
have  any  type  of  collider  as  the  program works 
with all mesh colliders. Once you have selected an 
object the Lock button on the Mesh Editor window 
will  become  enabled.  Rather  than  editing  the 
original mesh of the object you will be asked if you 
want to create a copy of the mesh to work on so it 
is  best  to  enter  a  unique name for  the new copy 
before you click on the Lock button. Of course you 
can chose to skip the mesh copy step and edit the 
original  instead.  The  copy  of  the  mesh  will  be 
placed in the Meshes folder of the program.

https://youtu.be/SbBdXhEx1ic
https://youtu.be/SbBdXhEx1ic


Selecting & Deselecting

You can now begin left clicking on 
the  locked  object  to  select  the 
vertices of the mesh. A small green 
sphere  will  appear  at  the  nearest 
vertex to where you clicked on the 
object.  You  can  select  multiple 
vertices  by  holding  down  the  left 
mouse  button  while  moving  the 
cursor  over  the  model  to  select 
more vertices. If you hold down the 
shift  key  while  clicking  near  the 
selected  vertices  they  will  be 
deselected. 

Changing Edit Modes

To work with edges, triangles and textures you can click on the buttons just below the objects 
name on the Mesh Editor window. As you mouse over the buttons a tooltip will let you know 
what the button does and the hotkey associated with that button. The same selection method 
works for all edit modes.  

Default Hotkey

The hotkey used by default is the Ctrl key for Windows and the Command key for Mac users. If 
you would like to change to another hotkey you can do this in the settings area which is covered 
later in this tutorial. The original hotkeys will still work as well as the newly selected key.  

Multiple Selecting &
Deselecting

To  select  whole  groups  at  a  time, 
hold  down  the  hotkey  while  left 
clicking and dragging the mouse and 
a selection box will appear. You can 
drag this box around the parts of the 
object you want to select.

To deselect simply do the same but 
while holding down the left shift key 
at the same time.



Changing Transform Modes

Just below the Edit Mode buttons are three buttons for changing the transform mode. The first 
is for moving (translating) the selected items, the second will rotate the items and the third will 
scale them. Moving, rotating and scaling work the same as for game objects in Unity. The only 
difference is the position of the handle when scaling and rotating. By default the handle will 
automatically position itself at the center of the selected items but you can override this by 
moving the handle to a new position. To do this first hold down the hotkey and then move the 
handle to a new position by dragging it. If you are in either the rotate or scale transform mode 
the handle will change to a translate handle while the hotkey is pressed. The scale and rotate 
will then happen relative to the new handle position.

You can also change the handle position manually by entering in the 
values for the x, y and z positions on the Mesh Editor window. You can 
also reset the handle by clicking on the Clear button just above these 
values.

World & Local Orientation

When moving the selected items you can choose to move them relative to the objects local 
space or world space by clicking on the button shown above. The button will toggle between 
local and world orientation.

Mesh Information

To learn more about the mesh you are 
working on,  you can mouse over the 
object  name  on  the  Mesh  Editor 
window to view the mesh details. The 
tooltip contains information about the 
number of selected items as well as the 
number of vertices and triangles in the 
mesh.  

Saving the Mesh as an Asset or Prefab 

At any time you can make a copy of the mesh and save it as an asset in the project folder by 
clicking on the left button shown in the image. By default it will be given the name entered at 
the top of the Mesh Editor window and be placed in the Meshes folder within the program 
folder. You can also save the current mesh as a prefab by clicking on the right button shown in 
the image. The prefab will be placed in the Prefabs folder within the main program folder.



The  buttons  on  the  Mesh  Editor  window  will  enable  or  disable 
themselves depending on whether that feature is available for the current 
edit mode and the currently selected items.

1. Quick Select
 
Selects all of the vertices, edges, triangles or textures depending on the current edit mode. 

2. Quick Deselect
 
Deselects all of the vertices, edges, triangles or textures depending on the current edit mode. 

3. Invert Selection
 
Selects the opposite of the currently selected items.

4. Delete Triangles
 
Deletes the currently selected triangles. 

5. Double Sided Triangles
 
Makes all of the currently selected triangles double sided. 

6. Reverse Triangles
 
Reverses the currently selected triangles.

7. Smooth Triangles
 
Averages the normals of the selected triangles to create a smooth appearance. 

8. Facet Triangles
 
Changes the normals of the selected triangles to create a faceted appearance.

9. Un-Weld All Vertices

This feature will split the vertices when the mesh shares vertices between adjacent triangles. 
This is useful if the texture coordinates and normals need to be different for each vertex.



Extruding Edges & Triangles

When you are in triangle or edge mode you can extrude the selected items by holding down the 
ctrl + shift keys before moving, rotating or scaling the items. You can extrude many edges or 
triangles  at  once  even  if  they  are  not  touching  each  other.  This  allows  for  very  fast  and 
symmetrical extrusion of meshes.

 

Auto Update UVs

When extruding the  triangles  or  edges  of  a  mesh,  the  texture  coordinates  may  need to  be 
updated. To do this, open the Options foldout area and tick the box for the Update UVs. The 
program will recalculate the texture coordinates using planar mapping.

Creating New Meshes and Submeshes

To  create  a  new  mesh  or 
submesh first select the triangles 
you  want  to  use  for  the  new 
mesh,  open  the  Split  Mesh 
foldout  section  in  the  window 
and  click  on  the  Split  Mesh 
button.  The  Create  Submesh 
button will add a new submesh 
instead  and  you  can  assign  a 
new material  to  it  from within 
the inspector. window.



Normalize Scale

This button will become enabled when the selected mesh has irregular scale values. Normally a 
mesh will have the same scale values in all three directions. This is important for many Unity 
features and makes editing the mesh easier. If you find that you need to normalize the scale of a 
mesh click on this button to set the scale values to 1. This feature will automatically adjust the 
mesh size to remain visually the same within the scene view.

Optimize Mesh

This feature creates tri-strips for the existing mesh if it is capable of optimization.

Flip X, Y, Z

Clicking on these buttons will flip the selected mesh in the X, Y and Z axes.

Options

The Options foldout section contains some settings that change the default 
behavior  of  the  program.  The  first  check  box  enables  or  disables  the 
selection of front facing polygons. The next check box turns on and off 
the rendering of the wireframe view which is handy if you need to select 
the back faces of the triangles.  Below this you can choose to enable the 
quick  highlights  which  render  faster  than  the  default  spheres  used  to 
highlight  the  vertices.  Normally  the  program will  select  all  coincident 
vertices and edges when selecting them but you can turn off this behavior 
by un-checking the next two buttons. You can also enable or disable the 
showing of the tooltips using the next check box. The last check box enables the automatic 
updating of the texture coordinates when extruding edges and triangles.   

Snap to Grid

From the  Mesh  Editor  window you can open the  Snap to  Grid  menu 
foldout to access the snap options. By checking the Enable box you can 
choose whether to snap to a certain step size while modifying the mesh as 
well as snapping to a certain rotation angle while editing the mesh. 

Pivot Point

You can change the position and rotation of the pivot point from within the 
Pivot Point foldout section. Click on Set To Center to move the proposed 
position of the pivot point or enter new values for the pivot point before 
clicking on the Update button to finalize the new position and rotation.



Settings Section

Within the settings foldout section you can change the default  locations 
where the meshes and prefabs will be saved to.

You can change the default hotkey used by the program by selecting a new 
key to use  from the drop down menu from within the Settings foldout 
section.

The undo and redo system used can be slow for meshes that contain more 
than 10000 vertices so by default  this feature is deactivated for meshes 
above this count. If your computer is fast then you may want to increase 
the Max Undo value.

When selecting vertices, edges and triangles the Epsilon Value is used to 
compare points that are considered to be equal. If you are working on a larger or smaller scale 
you can change the default epsilon value.

The  Smooth  Angle  is  used  during  the  triangle  smoothing  operation  to  determine  whether 
adjacent  triangles  should  be  smoothed.  Changing  this  value  changes  the  maximum  angle 
between triangles that should be smoothed.

The five color selection boxes change the default colors used for the selection box as well as the 
vertex, edge, triangle and texture highlighting.
 
The Save and Load buttons will save and load the settings used by the program. The Load 
Defaults button will reset the settings back to the original settings. The last settings will be 
saved automatically when the program is closed and loaded the next time you start the program.

Revert

The Revert  button will  reset  the mesh  copy back to  the original  mesh that  was  set  before 
clicking on the Lock button. If the original mesh was a copy that was overwritten when the 
program started then this may make the mesh appear to disappear. In this case you will need to 
manually set the mesh attached to the Mesh Filter back to the first mesh attached to the object.

Exporting

To export your new creations to the OBJ format you begin by first selecting the game object/s 
you would like to export and then clicking on the Window menu item in Unity, hovering over 
the Mesh Editor menu item and then the Tools menu item before selecting the type of export 
you want to perform. The exported object will be saved in the Geom folder in a subfolder called 
Exported Objects.



Full Undo/Redo

The Undo and Redo operations use the standard Unity hotkeys Ctrl-Z and Ctrl-Y to perform the 
operations. This works for all transformations of the mesh as well as for most of the triangle 
operations.  Remember  that  the Max Undo value determines  whether  the last  action can be 
undone.

Unlock/Exit

To return control back to Unity you can either click on the Unlock button or Exit the program. 
You will then be able to work as normal within the Unity editor.
 
FAQ

There is  a known issue of  inverted triangles sometimes  being produced while  extruding.  It 
results from two triangles sharing a vertex at a single point. The easiest solution is to extrude 
the triangles separately until this is fixed in a future update.
 
Thank You

We hope you find the program very useful  for  your editing needs and thank you for  your 
support.  If  you  have  a  suggestion  or  find  a  bug  then  please  let  us  know  by  writing  to 
support@meshmaker.com and we will do our best to add the changes to the next update.
 
 

To learn more about Mesh Editor and to view the tutorial videos you can visit 
MeshMaker.com

http://www.meshmaker.com/
mailto:support@meshmaker.com


Hotkeys and Button Guide

Left Click Select
Left Click + Shift Deselect
Ctrl/Command/Hotkey + Left Click & Drag Multiple Select
Ctrl/Command/Hotkey + Shift + Left Click & Drag Multiple Deselect
Ctrl Move Handle
G Switch Edit Mode
H Switch Transform Mode
P Toggle Orientation
Esc Unlock Object 
Ctrl + Alt + A Select All
Ctrl + Alt + D Deselect All
Ctrl + Alt + I Invert Selected
Ctrl + Alt + E Delete Selected Triangles
Ctrl + Alt + C Double Side Selected Triangles
Ctrl + Alt + R Reverse Selected Triangles
Ctrl + Alt + S Smooth Selected Triangles
Ctrl + Alt + F Facet Selected Triangles
Ctrl + Alt + U Un-Weld All Vertices
Ctrl + Alt + X Flip X Axis
Ctrl + Alt + Y Flip Y Axis
Ctrl + Alt + Z Flip Z Axis
Ctrl + Alt + O Optimize Mesh
Ctrl + Alt + H Clear Handle Position
Ctrl + Alt + J Snap To Grid
Ctrl + Alt + P Update Pivot Point


